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Restrictions 

The software described in this document is furnished under a license agreement and may be used or 
copied only in accordance with the terms of the license agreement. It is against the law to copy the software on 
any other medium except as specifically allowed in the license agreement. 

 

The licensee may make one copy of the software for backup purpose. No part of this software or 
document may be reproduced or transmitted in any form or by any means electronic or mechanical including 
photocopying and recording for any purpose without the written permission of NIC. 
 

Warranty 

This product is warranted for the period till the next changes are made in the software. 
 

Liability  

In no event NIC be liable for any damages, including loss of data arising out of the installation, 
maintenance, use, performance, failure or interruption of the software. Users are responsible to take backup of 
database on daily basis in suitable removable media. 
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1. Illustrations 

 

Sr. No. Screen ID Program Name 

Screens for All users For Login, Logout 

1 SCR01 Home page 

2 SCR02 Login 

Screens for End user and operator for data entry and report 

3 SCR03 Entry Specification 

4 SCR04 Report Specification 

Screens for Format administrator for entering Format Details 

5 SCR05 Format Specification 

6 SCR06 Column Specification 

7 SCR07 Code Specification 

8 SCR08 Row Specification 

9 SCR09 Password Specification 

10 SCR10 Time Limit Specification 

Screens for Structure administrator for entering Structure Details 

11 SCR12 Structure Details 

12 SCR13 Place Specification 

Screens for SIMNIC administrator 

13 SCR11 Structures Specification 

14 SCR14 Department Specification 

15 SCR15 Scripts Specification 

16 SCR16 Dictionary Specification 
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2. Introduction 

 

  Audience 
 

 All Ministries / departments of Central / State Government which device formats for collection of 
tabular information from line offices for effective decision making. 
 

 Introduction 
 

SIMNIC is a web-based application for data collection in dynamically created formats from field offices 
of Government departments at given frequency and given level on Internet.  

 
Field Offices - Offices are coded as per their reporting hierarchy (structure) to uniquely identify a offices 

e.g. State /Division /District /Taluka /Village are levels. Formats may be filled by any level (say Taluka) of 
State Govt. Dept. (say Revenue). Reports can be generated from any in between levels by State Department. 

 
Frequency - Reports can be generated for different frequency such as financial year, Calendar Year, 

Quarter, Month, Fortnight, Week, Day, once or latest. 
 
Computation of simple calculations in columns is also possible in SIMNIC, thus avoiding human errors. 

Only basic data is entered/ collected. 
 
 Passwords set for one format can be made applicable to formats of same reporting structure thereby 
avoiding multiple passwords. 
 

  Objectives  

               To Generate 
♦ Formats on fly 

♦ Single window framework for collection of data 

♦ Improve data collection methodology from paper forms to interactive computer generated 
data entry forms 

♦ Re-use previous data  

♦ To prevent change in submitted data (prevent data manipulation). 

♦ Multi-user  

♦ Uniform and one time coding 

♦ Multilingual (Unicode) 
 

   Scope of the Product 
 

Scope of this project is confined to Government agencies, departments and other government 
organizations which need the self defined formats for data collection in their respective areas. 

   Hardware and Software requirements 

♦ Server with Linux/ Windows Operating System with internet connectivity 

♦ MySql Database Management on above OS 

♦ J2SDK on above OS e.g. JDK 1.3 

♦ J2EE web server for above OS e.g. Jakarta Tomcat/ Web sphere 
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♦ C-DAC iPlugin for web fonts 

♦ Internet Explorer for windows clients having internet connectivity 
 

 References 
 

S.No. Title Publisher/Author  Version Release Date 

1. Quality Manual(NIC-QM) NIC Delhi 1.0 29-2-2004 

2. UM Template(NIC-TPL-004) NIC Delhi 1.1 29-2-2004 

3 Software Requirement Specifications 
(NIC-MHSC-SEC-SIMNIC-SRS) 

NIC Mumbai 1.0 3-6-2004 

4 Software Design Document  
(NIC-MHSC-SEC-SIMNIC-SDD) 

NIC Mumbai 1.0 3-6-2004 

 

   Problem Reporting 
In case of any queries problem related to SIMNIC following may be contacted. 
Shri. Yogesh Khadayate, NIC-MHSC, Room No. 616B, Mantralaya, Mumbai.  
                                         Ph: (022) 22793776 Email- y.khadayate@nic.in 
 

   Features 

♦ Web enabled system for on line submission of data 

♦ Based on state of the art software technology 

♦ User friendly and easy to use 

♦ Well managed access controls 

 

   Handling Instructions 
� Enable JavaScript in browser 
� Internet Explorer 6.0 should be available 
� Screen Resolution 800 * 600 minimum 
� Accept ActiveX control install on demand of iPlugin of C-DAC 

 

  Installation 
1. Load Tomcat and MySql on the system 
2. Load MySql database/ Table generation script by following command 

mysql –u root < mahasim.sql 

3. Give database access permissions to the system from the MySql database by following command  
GRANT all privileges ON mahasim.* TO mahasim@localhost identified by 

‘mHbcRbpDcf’; 

4. Unzip file in Tomcat /Web application folder  
Start MySql and Tomcat    
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 Specific operating instructions 
 
 General 

 
The SIMNIC administrator creates the participating departments, reporting structures and formats. 

Assigns administrator password for departments & structures for further access by department. 
 
The department administrator creates required format(s) for his department and assigns administrator 

password to format(s). 
 
The format administrator defines the columns, rows, and codes in format, give passwords to users (line 

offices) and specified time limit for filling data in the format. 
 
The structure administrator defines the levels and places for lines offices in his structure. 
 
The operator is a user who can make data entry on behalf of any user and also generated reports from 

data fed in formats by user(s). 
 
The format user (end user) enters data in format for his office (also line offices below) and report date. 

The user can make entry within the time limit only; he can see previous entered data but cannot modify (unless 
allowed by format administrator). He can also print reports for his location and also line offices below. 

 
The popup list is provided whenever available to simplify application usage. 
 
The date format is dd.mm.yyyy e.g. 17.07.1998 
 
The save button appears only if user has access to the screen and basic information (key values) is 

entered. 
 
When used first time on any computer finite time is required to download iPlugin (from C-DAC) for 

Client browser for Indian languages. 
 
To get the language fonts, click on desired language, when Home page re-appears, click Download fonts 

link in bottom right of Home page. 

  

See FAQ page on the site for common queries. 
 
This user manual is available online and can be seen by clicking User Manual link in Home page. 
 
The about link gives brief information about SIMNIC.  
 
The Hint is intimation to the user that the record displayed is new or old. 
 

The New button generally gives a blank entry form 

 

The Clear button clears the contents on input boxes on top of screen 
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The Save button saves the displayed information to database. 

 

The delete button deletes the displayed information from database. 

 

The Home button takes user to the Home page of SIMNIC. 

 

The Logout button terminates the user session with SIMNIC. 

 
The Go button fetches the information for display to user on screen. 
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Access the site by giving the URL http://mahasim.nic.in and then the page is displayed. 
 

1-SCR01: Home Page 

 
 
When the user opens up the home page, he is presented with a screen where he has to login first.  
 
For viewing Home page in Indian script language click the require Language link on bottom of the screen e.g. 
for Home page in Marathi click Marathi 
 
For login: 
1. Double Click on required department under ‘PARTICIPATING DEPARTMENTS’ on the left hand side. 
2. The department node will expand and show available formats ready 
3. Select the required format by click (Login link gets activated) 
4. Then click on Login to proceed for login in to selected format. 
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The User list is shown for 
easy selection. 
 
User Go option to find 
required line office/user. 
 
Select the appropriate one 
and give password. 
 
If format is in Indian 
script select the script 
keyboard and click OK. 
 
 
 
 
 
 
 
 
 
 
 
 

Post login page 
 
If login is successful, the 
Home Page will be displayed 
with some options available 
to login user in ‘OPTIONS’ 
 
Also logged in user 
information is displayed in 
‘LOGIN INFORMATION’ 

2-SCR02: Login 
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End user /operator can make Data Entry by clicking Data Entry option in ‘OPTIONS’ section: 
 

3-SCR03: Data Entry 

 
 

New data submission: Enter Report Date (dd.mm.yyyy or select from calendar), Row No. (applicable for multi 
row formats only) and click go button; a blank data entry screen will be presented for entering the data. 
Updating old data: Click on a Row No. on left hand side of screen and its corresponding record will be 
displayed on right hand side, if the data entry period (time limit) is not over the record can be updated /deleted.  
Save record by clicking on Save button 
Delete record by clicking on Delete button 
The saved record can be viewed in prescribed printable format be clicking View link. 
Description of fields 
 Format- The format in which user has logged in (Read only) 
 Place- The place in which user logs in or selected be operator (Read only) 
 Report Date- Date for which data is to be entered (dd.mm.yyyy) 
 Row No- for multi row format only, no. given to row 
 For example: 

 Row (Plan) No - (1 for Plan, 2 for SCP, 3 for TSP, 4 for OPST for shown example) 
Target Physical in No., Financial in Lacs. 
Etc.
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End user /operator /guest can generate Report by click on Compilation option in ‘OPTIONS’ section: 
 

4-SCR04: Report 

 
 
Required report can be generated by selecting from following : 
Report options – Code-code of Location for which records are to be displayed (blank for all), Report period for 
duration of report and row no. for specific rows in report format. 
Display options – 
For each level in structure check for 
Sr.No. to be given or not and in which style, Show record, Show empty record and show totals (generally show 
record at last level is checked) 
Search options – 
These options can be used to limit the output of above two options to some finer query 
 
Click Print to generate the report. 
 
To print the report use File -> Print in Internet Explorer 
 
For printing report in Color/Gray scale check that in Tools->Internet Options ->Advanced:  
Under Printing “Print background colors and images” is selected to show cell boundaries. 
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Format administrator can enter Format details by click on Title option in ‘OPTIONS’ section: 
 

5-SCR05: Format details 

 
Click on the Format Name in the left hand side of the page and its details will come in right hand side for updating.  
Enter the format id and click on Go button to get desired format 
For entering a new record click on new (for SIMNIC administrator only). 
For updating click on Save button and for deletion click on Delete button. 
Description of Fields  
 Format Id- ID given to format (read only, computer generated) 
 Format Name- Title of format that will appear on top while printing 
 Format Department- Department under which format is to be shown in Home page 
 Report Frequency- Frequency at which data is to be collected 
 Report Structure- Tells the structure used for data collection 
 Report Level- The top most level for which data is to be collected/ report generated 
 Report Depth- Level from which data will be collected 
 Multi row- No. of rows for which lowest level data is to be collected from same location 
 Row title – Title of row (for multi row formats) if any 
 Report script- Language (Script) used of the report 
 Column Heading- Column heading is divided in how many no. of rows 
 Password Scheme- ID of format whose passwords are to be used for user login 
 Format Ready- Is format ready for data entry Y/N 
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Format administrator can enter column details by click on Column option in ‘OPTIONS’ section: 
6-SCR06: Column details 

 
Specify column No and click GO button. 
Click on New to clean context of column no. box in top 
Click on Clear to clear the contents of the boxes in top. 
Click on Column Name on left hand side to get its details in right hand side for editing. 
For updating click on Save button and for deletion click on Delete button. 
Click Go to show already available column details 
 
Brief description of fields 
 Format Id- the format administrator login format (Read only) 
 Column No- number given to column (1 for column after sr.no., place and rows) 
 Column Heading - title of column  
 Column Default- Default value of column (available at the time of data entry by double clicking) for 
formula column type this box holds the computation formula e.g. [1]+[2] 
 Column Type- define the data type of that column 
 Column Unit- Unit of data in the column (if any) e.g. Kg, Rs. Lacs. 
 Column Width- Width of the column 
 Column Fraction - no. of decimal places in Numeric type and rows in Text box Column Total – 
Vertical Total of column data is required or not 
 Column Order- Give the order of the column (not used in current version) 
 Column Format- Give the format of the column in which data is to be shown while printing (e.g. 
000000.000, $###,###.###) 
 Column Align- Give the alignment of the data shown in column when printed 
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Format administrator can enter row details (for multi row formats only) by click on Row option in the 
‘OPTIONS’ section: 

7-SCR07: Row details 

 
 
Format Id will be administrators login format. 
Specify either Format Id or Row No or both and click GO button to move to that record. 
Click on Row Name on left hand side to get its details in right hand side for editing.  
For updating click on Save button and for deletion click on Delete button. 
 
Click Go to show already entered rows of the format. 
 
Brief description of Entries 
 Format Id- the format administrator login format (Read only) 
 Row no- number given to row (generally starts with 1) 
 Row Name- Name of row 
 Row Total- Y if the row is a total of other rows 
 Row Default- Formula for Row value calculation if Row Total is Y e.g. [1]+[2]+[3] 
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Format administrator can enter Code details (only format having codes for column values) by click on Code 
option in ‘OPTIONS’ section: 

8-SCR08: Code details 

 
Format Id will be administrators login format 
Give Column No. (which is defined as code in column details) & Code then click on Go to enter new code for 
the column. 
On left hand side click on any Value and its corresponding record will be displayed in right hand side for 
editing. 
Update record by clicking on Save 
Delete record by clicking on Delete 
Click Go to show available codes of format 
 
Brief description of entries 
 Format Id- the format administrator login format (Read only) 
 Column- Column no. for which codes are set (Read only) 
 Code- Code used for column value 
 Value- Value assigned to the code 
 



National Informatics Centre MHSC Mumbai SIMNIC : User Manual Page 14 of 27 

 

NIC-MHSC-SEC-SIMNIC-UM Version 3.0 Web copy Release:20.7.2009 

 

Format administrator can set passwords for user by click on Password option in ‘OPTIONS’ section: 
 

9- SCR09: Passwords 

 
Format Id will be administrators login format. 
Enter any Place/ User ID and click on Go to move to that record. 
On left hand side click on any Place and its corresponding record will be displayed in right hand side for 
editing. 
For updating click on Save button and for deletion click on Delete button.  
Click Go to show available Places of format. 
 
 Brief Description of fields: 
 Format Id- the format administrator login format (Read only) 
 User Id- Place code or administrator /operator /guest (Read only) 
 Place- Name of the place (for display only) 
 Password- Password for above user for login into above format (displayed as *) 
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Format administrator can set time limit by click on Time limit option in ‘OPTIONS’ section: 
 

10-SCR10: Time limit 

 
Format Id will be administrators login format. 
Enter Place ID and click on Go to move to that record. 
On left hand side click on any Place and its corresponding record will be displayed in right hand side for 
editing. 
For updating click on Save button and for deletion click on Delete button.  
Click Go to show available time limits of format. 
 
 Brief Description of fields: 
 Format Id- the format administrator login format (Read only) 
 Place Id- Id of place for which time limit is being set (Read only) 
 Place- Name of the place (for display only) 
 Date – Report date for which Tim limit is set (blank for all dates) 
 Extension – extra time given (in days) for entering data after report date above 
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SIMNIC administrator can define structures by click on Structures option in ‘OPTIONS’ section: 
 

11-SCR11: Structures 

 
 
Enter any StructureID and click on Go to move to that record. 
Click New to gives blank record for creating new structure  
On left hand side click on any Structure Name and its corresponding record will be displayed in right hand side. 
Update record by clicking on Save and Delete record by clicking on Delete 
 
Description of Fields 
 Structure Id- Id assigned to the structure (read only, computer generated) 
 Structure Name- Name given to structure for uniquely identifying 
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Structure administrator can define Structure details (levels) by click on Structure option in ‘OPTIONS’ section:  
 

12-SCR12: Structure details 

 
Structure Id will be administrators login format 
Enter Level Id and click on Go to move to that record. 
On left hand side click on any Level Name and its corresponding record will be displayed in right hand side. 
For updating record click on Save and for deleting record click on Delete 
Click on Go to show available records of that Structure Name 
 
Description of Fields 
 Structure Id- Login structure of administrator (Read only) 
 Level No- Level no. to be set (Read only) 
 Level Name- Name of that level 
 Level Start- Column position in Code from which the level code will start 
 Level Width- Width of above code 
e.g. For structure of State/ Division/ District/ Municipal body has following levels 

Level Name Start Width 

1 State 1 2 

2 Division 3 1 

3 District 4 2 

4 Municipal 
body 

6 2 
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Structure administrator can For Place details click on Place option in ‘OPTIONS’ Section 
 

13-SCR13: User/Place/Location details 

 
 
Structure Id will be administrators login format ID 
Enter any Structure ID or Place Code and click on Go to move to that record. 
On left hand side click on any Name and its corresponding record will be displayed on right hand side for 
editing. 
Update record by clicking on Save and Delete record by clicking on Delete 
 
Description of fields 
 Structure Id- Read only 
 Place code- Unique code assigned to place (fill end values with 0s) 
 Place Name- Name of that place 
 Level Id- Level of Place in Structure 
(select language in Home page to enter place name in that language)
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SIMNIC administrator can enter Departments details by click on Department option in ‘OPTIONS’ Section: 
 

14-SCR14: Department details 

 
 
Enter any Department Name click on Go to move to that record. 
Click New to clear the contents of Department Id on top 
On left hand side click on any Department Name and its corresponding record will be displayed on right hand 
side for editing. 
Update record by clicking on Save and Delete record by clicking on Delete button 
 
Description of Fields 
 Department Id- Id assigned to department (read only, computer generated) 
 Department Name- Name of that department 
(select language in Home page to enter department name in that language) 
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SIMNIC administrator can enter Script details by click on Script option in ‘OPTIONS’ Section: 
 

15-SCR15: Script details 

 
 
Enter any Script ID and click on go to move to that record. 
Click on any Name on left hand side to get its details on right hand side for editing 
For update click Save and for delete click Delete 
Description of Fields 
 Script Id- Id assigned to department (read only) 
 Script Name – Name of Script supported 
 Script Style (English No.) – Style entry for the above script name with English Numerals. 
 Script Style – Style entry for the above script name with Script Numerals. 
 Font file – Font file name provided for download. 
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SIMNIC administrator can update Dictionary by click on Dictionary option in ‘OPTIONS’ section: 
 

16-SCR16: Dictionary 

 
Enter English Word and click on Go to move to that record. 
Click on any Word on left hand side and get its details on right hand side for editing 
For update click Save and for delete click Delete 
 
Description of Fields 
 English- English word 
 HI - Hindi word for above English word 
(select language in Home page to enter word in that language) 
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3. General Instructions: 

 

  Back Up of data  
 
 MySql administrator can take up database backup by command 
  mysqldump –h [host name] mahasim > mahasimddmmyy.sql 

 

  Security Issues 
 

            1. Database access is limited to application server by granting permission to that server only. 
 2. User should not disclose any password to strangers. 
 3. User must logout from application after completion of work and before leaving the seat. 
 4. Auto session timeout after 30 minute idle operation. 

 

4. Glossary 
 

IE : Internet Explorer- Browser program to see Web enabled applications 
 

URL : Uniform Resource Locator 
 
 
 
 


